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S24 Interface



 1-2			                MAXON CINEMA 4D S24: A Tutorial Approach

Figure 1-1  The default interface of CINEMA 4D S24

               Figure 1-2  Various components of CINEMA 4D S24 interface

 

Figure 1-3  The flyout displayed
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Figure 1-4  The flyout displayed

Figure 1-5  The Asset Browser displayed
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Figure 1-6  The rendering options 
displayed in the flyout

Figure 1-7  The tools to create the parametric objects displayed in 
the flyout

Figure 1-8  The spline modeling tools displayed in the flyout
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Figure 1-9  The generators displayed in the flyout

Figure 1-10  Various generators displayed in the flyout

Figure 1-11  Various cloners displayed in the flyout

Figure 1-12  Various tools displayed in the flyout
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Figure 1-13  Various deforming tools displayed in the flyout

Figure 1-14  Various tools displayed in the flyout

Figure 1-16   Various light tools 
displayed in the flyout

Figure 1-15  Various camera tools 
displayed in the flyout
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Figure 1-18  Flyout displayed on choosing 
the Locked Workplane tool

Figure 1-17  Various options 
displayed in the flyout

Figure 1-19  The Animation toolbar
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 Figure 1-21  The Material Manager Figure 1-20  The  flyout displayed 
on choosing the Project button

  Figure 1-23  The Object Manager  Figure 1-22  The Coordinate Manager
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  Figure 1-24  The Attribute Manager  Figure 1-25  The Layers Manager 

Figure 1-26  The flyout displayed 
on choosing the View menu
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Figure 1-27  The flyout displayed on 
choosing the Cameras menu

Figure 1-28  The cascading menu displayed on choosing the 
Navigation option from the Cameras menu

Figure 1-29  The cascading menu displayed 
on choosing the Use Camera option
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Figure 1-30 The perspective camera 
projection mode

Figure 1-31  The parallel camera projection 
mode

  Figure 1-32  The left camera projection    Figure 1-33  The right camera projection

Figure 1-34  The front camera projection Figure 1-35  The back camera projection
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Figure 1-37  The bottom camera projectionFigure 1-36  The top camera projection

Figure 1-38  The cascading menu 
displayed on choosing the Axonometric 
option from the Cameras menu
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 Figure 1-39  The isometric camera projection Figure 1-40  The dimetric camera projection

Figure 1-41  The military camera 
projection

  Figure 1-43  The bird camera projectionFigure 1-42  The gentleman camera 
projection
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Figure 1-44  The frog camera projection Figure 1-45  The flyout displayed on choosing 
the Display menu

 

Figure 1-46  The object displayed in 
the viewport on choosing the Gouraud 
Shading option

Figure 1-47 The object displayed in the 
viewport on choosing the Gouraud Shading 
(Lines) option

Figure 1-48  The object displayed in the 
viewport on choosing the Quick Shading 
option

Figure 1-49  The object displayed in the 
viewport on choosing the Quick Shading 
(Lines) option
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Figure 1-50  The object displayed in 
the viewport on choosing the Constant 
Shading option

Figure 1-51  The object displayed in 
the viewport on choosing the Constant 
Shading (Lines) option

Figure 1-52  The object displayed in the 
viewport on choosing the Hidden Line 
option

Figure 1-53  The object displayed in 
the viewport on choosing the Lines 
option

Figure 1-54  The object displayed in 
the Wireframe and Quick Shading 
(Lines) shading modes

Figure 1-55  The Default 
Light window
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Figure 1-57  The cascading menu displayed on 
placing the cursor on the Level of Detail option

Figure 1-56  The partial view of the flyout 
displayed on choosing the Options menu

Figure 1-58  The object displayed with the Backface Culling option on and off 
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 Figure 1-59  The object displayed with the Isoline Editing option on and off 

Figure 1-60  The color of the objects displayed same as 
the color of layers on choosing the Layer Color option

Figure 1-61  Displaying the normals 
of the selected polygons
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Figure 1-63 The Layout 
drop-down list

Figure 1-62 The flyout displayed 
on choosing the Panel menu
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 Working with Splines



2-2			                                  MAXON CINEMA 4D S24: A Tutorial Approach

Figure 2-1  The model of door lock system

Figure 2-2 Choosing the Front option from the 
Menu in editor view

Figure 2-3  Choosing the 
Configure option from 
the Menu in editor view
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Figure 2-4  Choosing the browse button next to the Image text box

		

Figure 2-5  Choosing 
Rectangle from the 
Create menu

	

Figure 2-6  Setting the width and height of the rectangle
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Figure 2-8  Extrude added to the Object ManagerFigure 2-7  Choosing Extrude from the flyout

Figure 2-9 Rectangle extruded in 
the Perspective viewport

Figure 2-10  Choosing Spline Pen 
from the Command Palette

Figure 2-12  Shape of the keyholeFigure 2-11  The changed shape of the cursor
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Figure 2-13  Spline renamed as keyhole

 

Figure 2-14  Choosing Extrude from the Command Palette

Figure 2-15  keyhole extruded in the Perspective viewport
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Figure 2-16  Choosing Boole from the flyout

										        

Figure 2-17  Extrude connected to Boole

  Figure 2-18  The hole created in the Perspective viewport
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Figure 2-19  Handle placed 
in the front viewport

Figure 2-20  Handle extruded in the Perspective viewport

Figure 2-21 Choosing Circle 
from the main menu
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Figure 2-22  The position of Joint and 
Joint.1 displayed in the Perspective 
viewport

Figure 2-23  Joint and Joint.1 lofted to create a surface  
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Figure 2-25  Choosing the Background 
option from the main menu

Figure 2-24  Choosing Group Objects 
from the Object menu

Figure 2-27  The Display Color 
parameter activated

Figure 2-26  The Background Object 
selected in the Object Manager
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 Figure 2-28  The Picture Viewer window

Figure 2-29  Choosing the Save as option from the File menu

 

Figure 2-30  The Save dialog box
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Figure 2-31  The model of a 
hand bag

Figure 2-32  Rectangle placed in the 
Perspective viewport

Figure 2-33  Rectangle.1 added to the Object 
Manager

Figure 2-34  Rectangle.1 placed in 
the Perspective viewport
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  Figure 2-35  Rectangle.2 added to the Object Manager

Figure 2-36  Rectangle.2 placed in the Perspective viewport

Figure 2-38  Rectangle.3 placed in 
the Perspective viewport

Figure 2-37  Rectangle.3 added to the Object 
Manager
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Figure 2-39  Choosing Loft from the flyout

Figure 2-40  Rectangle.2 connected to Loft in the Object Manager

Figure 2-42  All rectangles lofted in 
the Perspective viewport

Figure 2-41   Rectangle, Rectangle.1, and Rectangle.3 
connected to Loft

Figure 2-43  Choosing Lathe from the flyout
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Figure 2-44  Circle connected to Lathe in the Object Manager

Figure 2-45   The handle of the 
hand bag created

Figure 2-46  The changed shape of the cursor 
in the Object Manager

Figure 2-47  The text placed in the 
Perspective viewport
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Figure 2-48  Text connected to Extrude in 
the Object Manager

Figure 2-49  The extruded text on the 
hand bag

Figure 2-50  The model of the cigar pipe

Figure 2-51  Ellipse displayed in the 
Front viewport

Figure 2-52  Ellipse.1 displayed in the 
Front viewport
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Figure 2-53  Circle displayed in the Front viewport

Figure 2-54  The profile of the pipe displayed

Figure 2-55  The splines connected with Loft
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Figure 2-56  The shape of the pipe displayed

Figure 2-57  The pipe with the fillet caps displayed

 Figure 2-58  The model of a chair  Figure 2-59  The model of a table clock



Chapter 3

 Introduction to 
Polygon Modeling
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Figure 3-1  The model of a table lamp

Figure 3-2  The base displayed in the Perspective viewport

                                                                                                                                                                                                                                                                                                            
                           

Figure 3-3 The body moved on the top of base

	

Figure 3-4  bodydesign1 displayed in the Perspective viewport
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Figure 3-5  Edit points of bodydesign1.1 moved

Figure 3-6  Edit points of bodydesign1.2 moved

Figure 3-7(a)  The shade moved on the top of body

Figure 3-7(b) The bodyconnect1 moved on the top of body
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Figure 3-8(a)  cloner placed on bodyconnect1

Figure 3-8(b)  Placing shadedesign1 on shade

Figure 3-9  placing shadedesign1.1 on shade

Figure 3-10  Moving inner edit point of shapedesign1.1
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Figure 3-11  Copies of Shapedesign1.1 placed

Figure 3-12  The model of a computer mouse

Figure 3-13  Cube created in the Perspective viewport
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Figure 3-15  Scaling the selected points of 
Computer mouse

Figure 3-14  The corner points of Computer mouse 
to be selected

Figure 3-17  Scaling the selected 
points of Computer mouse

Figure 3-16  The points to be selected
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Figure 3-18  The center points to be selected Figure 3-19  Scaling the selected 
points of Computer mouse

Figure 3-20  The selected points of Computer 
mouse

Figure 3-21  Scaling the selected 
points of Computer mouse
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Figure 3-22  The top and bottom center points 
of Computer mouse selected

Figure 3-23  Scaling the selected points of 
Computer mouse

Figure 3-24  The points to be selected

 Figure 3-25  Moving the selected points of Computer mouse
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Figure 3-26   The selected points of Computer mouse

Figure 3-27  Moving the selected points of Computer mouse

Figure 3-28  The top center points of Computer mouse selected

  Figure 3-29  Moving the selected points of Computer mouse
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Figure 3-30  The points to be selected

Figure 3-31  Rotating the selected points of Computer mouse

Figure 3-32  The points to be selected

Figure 3-33  Rotating the selected points of Computer mouse
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Figure 3-34  The points to be selected

Figure 3-35  Moving the selected points upward

Figure 3-36  The selected points of Computer 
mouse

Figure 3-37  Moving the selected 
points of Computer mouse
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Figure 3-38  The points to be selected Figure 3-39  Moving the selected points of 
Computer mouse

Figure 3-40   The selected edges in the Perspective viewport
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Figure 3-41  Scaling down the edges of Computer mouse in 
the Perspective viewport

Figure 3-42  The points to be selected Figure 3-43  Moving the selected points of 
Computer mouse

Figure 3-44  The points to be selected

Figure 3-45  Scaling and moving the points 
of Computer mouse

Figure 3-46  The points of Computer mouse to be 
selected
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Figure 3-47  Scaling the points of  
Computer mouse 

Figure 3-48 Moving the selected points in the Right 
viewport

Figure 3-49  Scaling the points of Computer mouse

Figure 3-50  Clicking on the right of the 
middle edge loop

Figure 3-51  A new edge loop added to the 
Computer mouse
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Figure 3-52 The slider displayed at the 
top of the viewport

Figure 3-53  A new edge added 
to Computer mouse

Figure 3-54  A new edge added to Computer 
mouse

Figure 3-55  The polygons selected
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Figure 3-56  The extruded polygons
of Computer mouse

Figure 3-58  An edge loop added to Computer 
mouse

Figure 3-57  An edge loop added to Computer 
mouse

Figure 3-60  The edges added to Computer 
mouse

Figure 3-59 An edge loop added to Computer 
mouse

Figure 3-61  The smoothened Computer mouse
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Figure 3-62  The Scroll wheel 
placed on Computer mouse

Figure 3-63 The selected polygons 
of Computer mouse

Figure 3-64  Spline created in the 
Top viewport

Figure 3-65  Cube placed in 
the Top viewport

Figure 3-66  The edges to be 
selected in the Top viewport
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Figure 3-67  The points to be selected Figure 3-68  Scaling the selected points

Figure 3-69  The edges selected Figure 3-70  Scaling the selected edges

Figure 3-71  The polygons to be selected Figure 3-72  The extruded edge loop
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Figure 3-73  The edges to be added

Figure 3-74  The polygons to be selected

Figure 3-75  The selected polygons
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Figure 3-76  The deleted polygons

)

Figure 3-77  The model of computer table

 

Figure 3-78  The Computer table in the Perspective viewport
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Figure 3-79  Adding an edge loop

Figure 3-80  The edge loops added 

 

Figure 3-81  The selected polygons of Computer table
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Figure 3-82  The selected polygons extruded in the Perspective viewport

Figure 3-83  Clicking on edge to create a new edge loop

Figure 3-84  The selected polygons of Computer table
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Figure 3-85  The selected polygons extruded in the Perspective viewport

Figure 3-86  Cube aligned in the Perspective viewport
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Figure 3-87  Cube.1 positioned in the Perspective viewport

Figure 3-88  Left side positioned in the Perspective viewport

Figure 3-89  Boole connected to Computer table
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Figure 3-90  The holes created in the side support of the Computer table

Figure 3-91  Creating an edge using the Plane Cut tool

Figure 3-92  Four new edge loops added to the Computer table
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Figure 3-93  The selected polygons of Computer table

Figure 3-94  The selected polygons extruded in the Perspective viewport
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Figure 3-95  The Keyboard support of Computer table

Figure 3-96  New edge loop created
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Figure 3-97  Another edge loop added to the Computer table

Figure 3-98  The selected polygons of Computer table
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Figure 3-99  The selected polygons extruded in the Perspective viewport

                                                                                                                                                                                                                                                                                                            
         

Figure 3-100  The selected polygons of Computer table
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Figure 3-101  The selected polygons extruded in the Perspective viewport

Figure 3-102  The selected polygons of Computer table
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Figure 3-103  The selected polygons extruded in the Perspective viewport

Figure 3-104  Clicking on edge to create a new edge loop
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Figure 3-105  Two new edge loops added to the Computer table

Figure 3-106  The selected polygons of Computer table
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Figure 3-107  The selected polygons extruded in the Perspective viewport

Figure 3-108  The selected polygons of Computer table
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Figure 3-109  The selected polygons extruded in the Perspective viewport

Figure 3-110  Clicking on edge to create a new edge loop
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Figure 3-111  The new edge loop added to the Computer table

Figure 3-112 The selected polygons of Computer table
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Figure 3-113 The selected polygons extruded in the Perspective viewport

    

Figure 3-114  Shelf1 positioned in the Perspective viewport
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Figure 3-115  Shelf1.1 positioned in the Perspective viewport

Figure 3-116  Choosing the Polygon Pen tool from the Modeling Tool Palette
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Figure 3-117  The highlighted polygon

Figure 3-118  Dragging the highlighted polygon 

 

Figure 3-119  The highlighted polygon of magazine stand
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Figure 3-120  Dragging the highlighted polygon

Figure 3-121  Highlighted polygon

Figure 3-122  Dragging the highlighted polygon
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Figure 3-123 Clicking on an edge

Figure 3-124  Clicking on second edge to create a new edge

Figure 3-125  Three new edges added to the magazine stand
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Figure 3-126  Highlighted polygon

Figure 3-127  Dragging the highlighted polygon downward

Figure 3-128   Clicking on the corner point
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Figure 3-129   The new edge created

Figure 3-130  The edge converted to an arc shape

Figure 3-131  Highlighted polygon
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Figure 3-132  The extruded polygon

Figure 3-133  Model of a vase

Figure 3-134  vase displayed in the Front viewport Figure 3-135  Selected Polygons
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Figure 3-136  Selected polygons scaled uniformly Figure 3-137  Selected Polygons scaled along  
Y-axis

Figure 3-138  Selected polygons moved 
downward

Figure 3-139   Selected Polygons Extruded

Figure 3-140   Bottommost polygons selected Figure 3-141  Selected polygons scaled along 
y-axis
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Figure 3-142  Selected polygons beveled Figure 3-143  Torus moved upward

Figure 3-144  Choosing Volume Builder 
from the Volume menu

Figure 3-145  Voxel objects displayed Figure 3-146  Voxel objects smoothened
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Figure 3-147  Choosing Subtract from the 
Mode drop-down list

   

Figure 3-148  Groove created on vase Figure 3-149  vase turns dark grey
	

Figure 3-150  The SDF Smooth layer added to the ObjectProperties area
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Figure 3-151  vase smoothened Figure 3-152 Choosing Cloner from 
the MoGraph menu

Figure 3-153  Cloner placed on vase Figure 3-154  Cloner.1 placed on vase
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Figure 3-155  vase displayed in the viewport

Figure 3-156  List of all the objects in the Object Manager
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Figure 3-157  The model of a chair

 									       



Chapter 4

Sculpting
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Figure 4-1  The model of a candle

Figure 4-2  The polygons to be selected

Figure 4-3  Moving the polygons of the Candle downward
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Figure 4-4  Scaling down the polygons of Candle

Figure 4-5  Selecting Sculpt from the Layout drop-down list
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Figure 4-6  The Sculpt layout

Figure 4-7  The Sculpt Expression [Sculpt] tag added to the Object Manager

 

Figure 4-8  The strokes added Figure 4-9  The Invert check box selected in the Settings 
area in the Attribute Manager
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Figure 4-10  Strokes added to 
the Candle

Figure 4-11  Strokes added 
on the top of Candle

 

Figure 4-12 Adding strokes to the 
bottom of the Candle

Figure 4-13  More strokes added 
to the bottom of the Candle 

Figure 4-14 Adding strokes to the 
top of Candle

Figure 4-15  The smoothened surface 
of Candle
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Figure 4-16  The Wick of the Candle

Figure 4-17  The ice cream cone
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Figure 4-18  The Cone displayed in the Perspective viewport

Figure 4-19  Choosing the Subdivide tool from the Sculpting menu

Figure 4-21  The strokes addedFigure 4-20  Applying strokes on the 
top of the Cone
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Figure 4-22  Cone smoothened 
using the Smooth tool

Figure 4-23  Creating a pattern on 
Cone in the Perspective viewport

Figure 4-24  Creating a pattern on 
Cone using the Inflate tool

Figure 4-25  The pattern 
displayed on Cone
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Figure 4-26  Smoothening the surface 
of Cone using the Smooth tool

Figure 4-27  The Scoop displayed 
in the Perspective viewport

Figure 4-28  Adding strokes on the Scoop 
in the Perspective viewport

Figure 4-29   Adding stroke 
on Scoop using the Pull tool
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Figure 4-30   Creating the  pattern 
on Scoop in the Perspective viewport

Figure 4-31 The peak of Scoop 
created

Figure 4-32  The smooth peak of the 
Scoop in the Perspective viewport
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Figure 4-33  The sculpted vase

.

Figure 4-34  The c04_tut3_start.c4d file

 

Figure 4-35  The Sculpting menu displayed
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Figure 4-36  The sculpting level and polygon count displayed 

Figure 4-37 Strokes applied on the upper part of Vase
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Figure 4-38 Vertical strokes applied on the upper part of Vase

Figure 4-39 Strokes applied on the top of vertical strokes

Figure 4-40  Strokes applied on the remaining part of Vase



4-14			                                 MAXON CINEMA 4D S24: A Tutorial Approach

					   

Figure 4-41  A barrel with cracks

 



Chapter 5

Texturing
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Figure 5-1  The textured model of a dice

Figure 5-2  The c05_tut1_start.c4d file
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Figure 5-3  Choosing New Default Material from the Material Manager menu 

Figure 5-4  Displaying the material slot in the Material Manager

Figure 5-5  The Reflectance check box selected
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Figure 5-6  The matDice material 
applied to Cube

Figure 5-7  The Dot material applied to dots of the Cube



Texturing	 5-5

  Figure 5-8  Choosing the browse button

Figure 5-9  The matFloor applied to Floor
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  Figure 5-10  The textured dining table set

Figure 5-11  The c05_tut2_start.c4d file

Figure 5-12  The Wood_Texture.jpg added to the Color area of Attribute Manager



Texturing	 5-7

Figure 5-13  The matChair applied to the chairs

Figure 5-14  The Material Tag “matChair” 
in the Object Manager
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Figure 5-15  Various stone materials displayed in the Asset Browser

Figure 5-16  The Material Tag “Marble - Green - 
Shader” selected in the Object Manager
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Figure 5-17  The Marble - Green - Shader texture uniformly projected on the Floor

Figure 5-18  The matGlass material applied to the Glasses
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Figure 5-19  The matCover material 
applied to the material slot

 

Figure 5-20  The Material Tag “matCover” selected 
in the Object Manager
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Figure 5-21  The matCover material applied to Table cover

Figure 5-22  The matTableMats material applied to the Table mat group
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Figure 5-23 The flyout displayed 
on choosing the triangle button 
next to the Texture parameter 

Figure 5-24  The Shader Properties area in the Attribute 
Manager

Figure 5-25  The Gradient Knot 
Settings dialog box
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 Figure 5-26  The matWine material applied to Wine bottle

Figure 5-27  The matLabel texture displayed 
in the Color area of Material Manager
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Figure 5-28  The matLabel texture applied to Wine bottle 

	

Figure 5-29  Selecting the Material Tag “matLabel” 
in the Object Manager
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Figure 5-30  The matLabel material 
projected properly on the wine bottle 
in the Perspective viewport

Figure 5-31  The matCap material 
applied to the Wine bottle cap

Figure 5-32  The matplate material 
applied to the plates
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Figure 5-33  The exterior scene with the materials applied

Figure 5-34  The c05_tut3_start.c4d file
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Figure 5-35  Choosing New Node 
Material from the Create menu

Figure 5-36  New node material created 
in the Material Manager

Figure 5-37  The Nodes window 
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Figure 5-38  Choosing Load Texture from the shortcut menu

Figure 5-39  The floor texture.jpg node added to the Color input of the Diffuse.1 node
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Figure 5-40  The floor material displayed

Figure 5-41  The wall material displayed
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Figure 5-42  The cascading menu displayed

Figure 5-43  The mattable material displayed
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Figure 5-44  The matcup material displayed

Figure 5-45  The matglass material displayed
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Figure 5-46  The camera model

Figure 5-47  The final output



Chapter 6

 Lighting
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Figure 6-1  The torch light

Figure 6-2  The c06_tut1_start.c4d file

Figure 6-3  The flyout displayed 
with various tools
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Figure 6-4  The rendered view of the Perspective viewport 

 

Figure 6-5  Light.1 displayed in the Perspective viewport
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Figure 6-6  The illuminated night scene

			   Figure 6-7  The c06_tut2_start.c4d file
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Figure 6-8  Light positioned in the scene

Figure 6-9  Light.1 positioned in the scene
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Figure 6-10  Lights positioned in the Perspective viewport

Figure 6-11  Light.8 created in 
the Top viewport
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Figure 6-12  Light.8 positioned in the scene

								          

Figure 6-13  The light house 

Figure 6-14  The c06_tut3_start.c4d file
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Figure 6-15  The spot light positioned in the Perspective viewport

Figure 6-16  The Area lights positioned in the Perspective viewport

Figure 6-17  Choosing Physical 
Sky from the main menu
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Figure 6-18  Physical Sky added to the Object Manager

Figure 6-19  The Time and Location area

      Figure 6-20  The living room scene
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Figure 6-21  The scene after adding lights to it

 

	



Chapter 7

 Rigging



 7-2			                     	      MAXON CINEMA 4D S24: A Tutorial Approach

Figure 7-1 The rig of the hand

Figure 7-2  The c07_tut1_start file

 Figure 7-3  Clicking on the shoulder joint of the hand
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 Figure 7-4  Bone structure created 

 Figure 7-5  All joints aligned in the Front viewport
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Figure 7-6  Choosing the Create 
IK Chain from the main menu

Figure 7-7  The IK chain created in the Perspective viewport



Rigging	    7-5

Figure 7-8  The changed icon of wrist_joint.Goal

Figure 7-9 The shoulder control in the Perspective viewport
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       Figure 7-10  Displaying the controllers of hand

 

Figure 7-11  The changed icon of shoulder_joint.Pole

Figure 7-12  Hierarchy for controls in the 
Object Manager
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Figure 7-13  Choosing Constraint from the 
shortcut menu

Figure 7-14  All joints and controls rotating along with 
shoulder control in the Perspective viewport
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Figure 7-15  The wrist_joint and end_joint rotating along with wrist control

Figure 7-16  Position of shoulder_joint.Pole changed 
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Figure 7-17  Elbow movement controlled by wrist_joint.Goal 

Figure 7-18  Elbow rotation controlled by 
shoulder_joint.Pole 
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Figure 7-19  Skin added to the Object Manager

Figure 7-20  Rig for a table lamp
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Figure 7-21  The c07_tut2_start file

Figure 7-22  The main control in the Top viewport
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Figure 7-23  The support control in the 
Perspective viewport

Figure 7-24  The center control in the 
Perspective viewport

Figure 7-25  The lamp control in the 
Perspective viewport

Figure 7-26  All controls connected in the Object Manager
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Figure 7-27  The table lamp moving 
along with main control

Figure 7-28  Supports and lamp shade 
rotating along with support control

Figure 7-29 The support2 and lamp 
shade rotating  along with center control

Figure 7-30  The lamp shade rotating  
along with lamp control
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Figure 7-31 Rig for a human leg
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Animation
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Figure 8-1  The animated logo at frame 65

Figure 8-2  The c08_tut1_start.c4d file

Figure 8-3  Choosing the Add Keyframe option from the shortcut menu



Animation	 8-3

	

Figure 8-4  Timeslider set to frame 20

Figure 8-5  The space added between the text

Figure 8-6  The CADCIM text at frame 65
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 Figure 8-7  The CADCIM text at frame 75

Figure 8-8  Choosing Show FCurves 
from the shortcut menu
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Figure 8-9  The Timeline (Dope Sheet) window

Figure 8-10  Selecting all the keys in the Timeline (Dope Sheet) window
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Figure 8-11  Displaying the linear shape of curves

 

Figure 8-12  The basket ball at frame 66

Figure 8-13  The c08_tut2_start.c4d file
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Figure 8-14  The basketball at frame 0

Figure 8-15  The basketball at frame 10
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Figure 8-16  The basketball at frame 20

Figure 8-17  The basketball at frame 30
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Figure 8-18  The basketball at frame 34

	

Figure 8-19  The basketball at frame 150
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Figure 8-20   Selecting the keyframe from the Timeline (Dope Sheet) window

Figure 8-21   Squashed basketball at frame 40
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Figure 8-22   Selecting the keyframe from the Timeline (Dope Sheet) window

Figure 8-23   Moving the tangents in the Timeline (Dope Sheet) window
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Figure 8-24   Moving the tangents at other frames 

Figure 8-25  Moving cart at frame 45

Figure 8-26  The c08_tut3_start file
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Figure 8-27  Choosing Align to Spline from 
the shortcut menu

Figure 8-28  The Align to Spline Expression 
[Align to Spline] tag in the Object Manager

 

Figure 8-29  Spline displayed in the Spline Path edit box

Figure 8-30  cart aligned with Road
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Figure 8-31  cart at frame 50

 

Figure 8-32  Selecting Animate from 
the Layout drop-down list

Figure 8-33  The Animation layout displayed
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Figure 8-34  The modified size of the Timeline panel

Figure 8-35  Selecting all keyframes

Figure 8-36  Choosing Copy from the Edit menu

Figure 8-37  Copied keyframes
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Figure 8-38  All keyframes for Sphere1

Figure 8-39  The c08_exr01_start file



Chapter 9

Introduction to
 UV Mapping
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Figure 9-1  The final output 

Figure 9-2  The c09_tut1_start.c4d file

Figure 9-4  The Layout 
drop-down list

Figure 9-3  The material applied to Pencil
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Figure 9-5  The BP UV Edit layout

Figure 9-6  Choosing the Paint Setup Wizard tool

Figure 9-7 The BodyPaint 3D 
Setup Wizard  dialog box

Figure 9-8  The STEP 2: UV Setup area
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Figure 9-9  The Material Options area in the BodyPaint 
3D Setup Wizard dialog box

Figure 9-10(a)  The modified UV Mesh of Pencil

Figure 9-10(b) Scaled UV polygon of Pencil
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Figure 9-11  The matPencil_Color.tif option chosen from the Textures menu

Figure 9-12  The selected polygons of Pencil

Figure 9-13  The mirrored polygons
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Figure 9-14  The outlined polygons

Figure 9-15  The yellow color in the selected area of the canvas

Figure 9-16  The black color in the selected area of the canvas

Figure 9-17  Color filled in the remaining parts of pencil
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Figure 9-18  Choosing the browse button in the Attribute Manager

Figure 9-19  The texture applied to Pencil

Figure 9-20  The top polygon of the Eraser selected
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Figure 9-21  The top polygon aligned in the Texture View

Figure 9-22  The text placed inside the white outline
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Figure 9-23  The texture applied to Eraser

Figure 9-24  The 3D model after applying body paint
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Figure 9-25  The c09_tut2_start.c4d file

Figure 9-26  The Color area displayed
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Figure 9-27  Choosing Paint > Fill Bitmap tool from the Texture UV Editor menu

Figure 9-28  The model filled with the selected color in the Perspective viewport
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Figure 9-29  The texture applied to chest of the model

Figure 9-30  The clothes painted using the Brush tool in the Texture View
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Figure 9-31  The final 
output

	



Chapter 10

Compositing 3D 
Objects
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Figure 10-1  The final composition

Figure 10-3  The Camera Calibrator tag added 
to the Object Manager

Figure 10-2   Choosing Camera Calibrator  
from the shortcut menu
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Figure 10-4  The line created in the Perspective viewport

 
	

Figure 10-5  The position of first line in the Perspective viewport
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Figure 10-6  The position of second line in the Perspective viewport

Figure 10-7  The two red lines representing the X-axis
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Figure 10-8  The focal length of the camera solved

Figure 10-9  The pin snapped to the fourth line in the scene

 

Figure 10-10  The Camera Object[Camera] button
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Figure 10-11  The plane positioned in the scene

Figure 10-12  Text displayed in the scene
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Figure 10-13  The rendered scene

Figure 10-14  All objects in the Perspective viewport
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Figure 10-15  All objects in the Object Manager

Figure 10-16  The lines and pin in the scene
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Figure 10-17  The 3D elements composited in the scene
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Rendering
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Figure 11-1  The final rendered table clock

Figure 11-2  The c11_tut1_start.c4d file
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Figure 11-3  Displaying the rendered view

Figure 11-4  The flyout displayed on choosing the Effect button 

Figure 11-5  The Global Illumination area
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Figure 11-6  The rendered clock

	

Figure 11-7  The rendered clock

 Figure 11-8  The flyout displayed on choosing the Multi-Pass button
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Figure 11-9  Selecting the Alpha Channel check box in the Render Settings window

Figure 11-10  The rendering process in the Picture Viewer window
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 Figure 11-11  The render passes displayed in the Picture Viewer window

 Figure 11-12  Displaying the Alpha 
pass in the Picture Viewer window

 Figure 11-13  The Ambient Occlusion pass 
displayed in the Picture Viewer window

Figure 11-14  The Reflection pass displayed 
in the Picture Viewer window

Figure 11-15  The Global Illumination pass 
displayed in the Picture Viewer window
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Figure 11-16  The Shadow pass displayed 
in the Picture Viewer window

Figure 11-17 The Diffuse pass displayed 
in the Picture Viewer window

Figure 11-18  The render of the beer mug

 Figure 11-19  The c11_tut2_start.c4d file
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Figure 11-20  The floor texture applied

Figure 11-21  The Caustics area in the Render Settings window
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Figure 11-22 The Illumination area displayed in the Material Editor window

 								         

Figure 11-23  Scene after rendering

 



Chapter 12

MoGraph
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Figure 12-1  The abstract model to be created

Figure 12-2  Cube positioned in the 
Perspective viewport

Figure 12-3 Cloner displayed in the 
Perspective viewport

Figure 12-4  Cloner.1 displayed in the Perspective viewport
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Figure 12-5  The disco light effect at frame 60

Figure 12-6  The c12_tut2_start.c4d file

Figure 12-7  Selecting Radial from the Mode drop-down list
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Figure 12-8  Selecting Random from the Clones drop-down list

	

Figure 12-9 The clones of Light displayed in the Perspective viewport



MoGraph	        12-5

 

Figure 12-10  Choosing Random from the cascading menu

Figure 12-11  The Custom Color option from the Color Mode 
drop-down list
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Figure 12-12  Selecting the Add option from the Blending 
Mode drop-down list

                                                                                                                                                                                                                                                                                                            
          

Figure 12-13  The rendered view at the current frame

	

Figure 12-14  The shattering effect at frame 81
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Figure 12-15  The c12_tut3_start.c4d file

Figure 12-16  Choosing PolyFX 
from the main menu

Figure 12-17  The fragmented Kettle in the 
Perspective viewport

Figure 12-18  The abstract animation at frame 0
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Figure 12-19  The MoSpline displayed in the Perspective viewport

Figure 12-20  The clones displayed in the Perspective viewport

Figure 12-21  The clones displayed in the viewport



MoGraph	        12-9

Figure 12-22  The rendered image at frame 48

Figure 12-23  The objects in the Object Manager

Figure 12-24  The abstract model
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Working with XPresso
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Figure 13-1  The traffic signal with the red light on

Figure 13-2  The c13_tut1_start.c4d file
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Figure 13-3  Choosing Add User Data from the menu in the Attribute Manager

	

Figure 13-4  The Manage User Data dialog box
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Figure 13-5  Selecting Float Slider from the Interface drop-down list

	

Figure 13-6  The Red spinner added to the User Data 
area in the Attribute Manager

Figure 13-7  The Yellow spinner added to the User Data area in 
the Attribute Manager

Figure 13-8  The Green spinner added to the User Data area in the 
Attribute Manager
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 Figure 13-9  Choosing XPresso from the shortcut menu

Figure 13-10  The XPresso Editor
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Figure 13-11  Choosing Object from the shortcut menu

Figure 13-12  Choosing Red from the flyout in the XPresso Editor
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Figure 13-13  The Red, Yellow, and Green output ports added to the Traffic-Lights node

Figure 13-14  Choosing the Compare option from the shortcut menu in the XPresso Editor
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Figure 13-15  Choosing the Condition option from the shortcut menu in the XPresso Editor
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Figure 13-16   Selecting Color from the Data Type drop-down 
list in the Node Properties area
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Figure 13-17  The Red-Glass, Yellow-Glass, and Green-Glass nodes added 
in the XPresso Editor

Figure 13-18  Connection established between the Red output port of the Traffic-Lights 
and Compare 1 nodes
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Figure 13-19  Connection established between the Compare 1 and Condition 1 nodes

Figure 13-20  Choosing Color from the flyout in the XPresso Editor

Figure 13-21  The red light activated in the Perspective viewport
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Figure 13-22  Connection established between the Yellow output port of the 
Traffic -Lights and Compare 2 nodes

Figure 13-23  Connection established between the Compare 2 and Condition 2 nodes
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Figure 13-24  Choosing Color from the flyout in the XPresso Editor

Figure 13-25  The yellow light activated in the Perspective viewport

Figure 13-26  The green light activated in the Perspective viewport
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Figure 13-27  The shortcut menu displayed on right-clicking in the User 
Data area

Figure 13-28  The deformed object

Figure 13-29  The c13_tut2_start.c4d file
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Figure 13-30  The Gift node added in the XPresso Editor
	

Figure 13-31  The Expand spinner in the Attribute Manager

Figure 13-32  The Fillet spinner added to the Attribute Manager
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Figure 13-33  The Cube_Length and Cube_Width spinners added 
to the Attribute Manager

Figure 13-34  Choosing Expand from the flyout in the XGroup area
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Figure 13-35  The Fillet output port added to the Gift node

Figure 13-36  The Bulge node in the XGroup area
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Figure 13-37  Connection established between the Gift and Bulge nodes

Figure 13-38  Gift expanded in the Perspective viewport

Figure 13-39  The deformation of the Gift softened in the Perspective viewport
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Figure 13-40  The two Gift nodes connected with each other

Figure 13-41  The Gift scaled in the Perspective viewport

Figure 13-42  The logo 
at frame 49



Project 1

Creating an Indoor 
Scene

Figure P1-1  The final output
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Figure P1-2  The selected polygons displayed

Figure P1-3  The Base displayed in all viewports

Figure P1-4  Mattress aligned in all viewports



Creating an Indoor Scene					     P1-3                                                                                   

Figure P1-5  The Leg1 displayed in the Perspective viewport

Figure P1-6  Two legs displayed in the Perspective viewport

Figure P1-7  The Leg1.2 displayed in the Perspective viewport



P1-4		    	 MAXON CINEMA 4D S24: A Tutorial Approach

Figure P1-8  Clicking on an edge 

Figure P1-9  The selected polygons Figure P1-10 The selected polygons bevelled

Figure P1-11  The Leg1.3 aligned in all viewports



Creating an Indoor Scene					     P1-5                                                                                   

Figure P1-12  The Support1 displayed in all viewports

Figure P1-13  The Support aligned in all viewports
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Figure P1-14  The Rod aligned in all viewports

Figure P1-15  Choosing Cloth Collider from the shortcut menu



Creating an Indoor Scene					     P1-7                                                                                   

Figure P1-16  Bedsheet aligned in all viewports

Figure P1-17  The Cloth Expression [Cloth] tag added to the 
Object Manager

	

Figure P1-18  The bedsheet aligned on Mattress
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Figure P1-19  The Wardrobe aligned in all viewports

Figure P1-20  The selected polygons displayed

Figure P1-21  The selected polygons extruded



Creating an Indoor Scene					     P1-9                                                                                   

Figure P1-22  The newly added edges displayed

Figure P1-23  The selected polygons

Figure P1-24  The Handle aligned in all viewports
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Figure P1-25  The Handle.1 aligned in all viewports

Figure P1-26  Two vertical edge loops added

Figure P1-27  Six horizontal edge loops added



Creating an Indoor Scene					     P1-11                                                                                   

Figure P1-28  The selected polygons

Figure P1-29  Drawer 1 aligned in all viewports

Figure P1-30  Knob 1 positioned in all viewports
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Figure P1-31  The Knob 1, Knob 1.1, and Knob 1.2 displayed

 

Figure P1-32  The Drawers.1 aligned in all viewports

Figure P1-33  The added edge loop displayed



Creating an Indoor Scene					     P1-13                                                                                   

Figure P1-34  The polygons selected

	

Figure P1-35  The selected polygons extruded

Figure P1-36  Cover1 displayed in the Perspective viewport
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Figure P1-37  The Lights displayed in all viewports

Figure P1-38  The Lights.1 aligned in all viewports

Figure P1-39  The Mat aligned in all viewports
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Figure P1-40  The Wooden Frame aligned in all viewports

Figure P1-41  The added vertical edges displayed
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Figure P1-42  The horizontal added edges displayed

Figure P1-43  The polygon selected

Figure P1-44  The Wooden Frame extruded in the Perspective viewport
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Figure P1-45  Displaying the Chair positioned in the Perspective viewport

Figure P1-46  The Clock positioned in the Perspective viewport



Project 2

Texturing an Indoor 
Scene
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Figure P2-1  The final output

Figure P2-2  The Project2_start.c4d file
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Figure P2-3  The bottom polygons of Room selected

 	

Figure P2-4  The polygons of the walls and roof selected

 

		

Figure P2-5  The Wall material assigned to walls of the Room
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Figure P2-6  Choosing Surfaces > Tiles from the flyout

Figure P2-7  Choosing Hide Objects from the main menu 
in the Object Manager 
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Figure P2-8  The Mattress material displayed

Figure P2-9  The Bedsheet texture created in the Shader Properties area
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Figure P2-10  The Bedsheet material displayed

Figure P2-11  The Drawer mat material applied to drawers

	

Figure P2-12  The selected polygons of Wardrobe
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Figure P2-13 Selecting the rest of the 
polygons

 

Figure P2-14  The Almirah and Mirror materials applied to Wardrobe in the 
rendered scene
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Figure P2-15  The Chair mat material applied

Figure P2-16  The materials applied to Lights and Light.1 groups

Figure P2-17  The selected polygons of Wooden Frame
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Figure P2-18  The selected polygon of Wooden Frame

Figure P2-19  The Painting material mapped to Wooden Frame

Figure P2-20  The final rendered scene



Project 3

Creating an Exterior 
Scene

Figure P3-1  The final output
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Figure P3-2  The material displayed on ground

Figure P3-3  The wall aligned in all viewports

Figure P3-4  The wall.1 and wall.2 aligned in all viewports
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Figure P3-5  The wall.3 and wall.4 aligned in all viewports

Figure P3-6  The material displayed on wall

Figure P3-7  The rod aligned in all viewports
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Figure P3-8  The support and its copies aligned in all viewports

Figure P3-9  The door.1 aligned in all viewports

Figure P3-10  The handle1 aligned in all viewports
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Figure P3-11  The material displayed on door1

Figure P3-12  The material displayed on rod

Figure P3-13  The material displayed on all the supports
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Figure P3-14  The material displayed on handle1

Figure P3-15  The gate2 displayed in the Perspective viewport

Figure P3-16  The handle2 aligned in all viewports
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Figure P3-17  The House01 aligned in all viewports

 

Figure P3-18  Selected polygons of House01

Figure P3-19  The mathousewall material displayed on all selected polygons
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Figure P3-20  Roof  polygons of House01 selected

Figure P3-21  The matroof material displayed on all selected polygons

Figure P3-22  Door polygons of House01 selected
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Figure P3-23  The matwood material displayed on all selected polygons

Figure P3-24  The door_handle aligned in all viewports
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Figure P3-25  The flooring1 aligned in all viewports

Figure P3-26  The flooring2 aligned in all viewports

Figure P3-27  The matflooring material displayed on flooring1
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Figure P3-28  The matflooring material displayed on flooring2

Figure P3-29  The car aligned in all viewports

Figure P3-30  Copy of tree scaled and placed
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Figure P3-31  Trees aligned in all viewports

Figure P3-32  Pots aligned in all viewports

Figure P3-33  Plants aligned in all viewports
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Figure P3-34  Applying strokes on the ground

Figure P3-35  Grass spread all over the ground


